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GII-6. GEODEZIJA IR KARTOGRAFIJA GIS SISTEMOJE 5 LABORATORINIS DARBAS 

SMULKESNIO MASTELIO ŽEMĖLAPIO SUDARYMAS NAUDOJANT STAMBESNIO 
MASTELIO ŽEMĖLAPIO DUOMENIS 

Atlikimo terminas:  2007 m. liepos 15 d., 16.30; tai preliminarus terminas, dėstytojas gali jį 

patikslinti  

Praktinio darbo vertinimas: Šis praktinis darbas vertinamas iki 12 balų, jo vertė sudaro 7 proc. viso kurso 

bendro paţymio. 

 

APRAŠYMAS IR UŽDAVINIAI 

Uţduotis skirta supaţindinti su topografinio atvaizdavimo specifika. Kuriant topografinį ţemėlapį 

projektavimo pasirinkimų nėra daug. Kartografas naudoja standartinius visuotinai priimtus simbolius, kurie 

tvarkomi pagal sukurtas tam tikro ţemėlapio mastelio specifikacijas. Specifikacijose gali būti generalizavimo 

taisyklių. Tai ţemėlapių rodymo tam tikru masteliu taisyklės.  

 

Šioje uţduotyje naudodami stambesnio mastelio duomenis gausime smulkesnio mastelio ţemėlapio 

duomenis. Bus naudojami tik kai kurie topografinio ţemėlapio elementai.  

 

Šiame laboratoriniame darbe dirbsite su keliais ArcGIS įrankiais, kuriuos naudodami galėsite kurti Anykščių 

miesto teritorijos skaitmeninių duomenų simbolizaciją. Bus taikomos erdvinės analizės programos (Spatial 

Analyst), redaktoriaus (Editor), generalizavimo (Generalization) ir atvaizdavimo (Representation) įrankių 

juostų funkcijos.  

 

Įvykdę uţduotį, turėtumėte suprasti šiuos terminus ir sąvokas: 

 Techninių reikalavimų reglamentas 

 Simbolikos dimensija (Dimension of symbology) 

 Generalizavimas 

 Rasterizavimas (Rasterization) 

 Rastro retinimas (Thinning raster) 

 Supaprastinimas (Simplification) 

 Glodinimas (Smoothing) 

 Topologija 

 Failinė duomenų bazė 

 Kartografinis atvaizdavimas (Cartographic representation) 

 

ATSISKAITYMO REIKALAVIMAI 

Šį dokumentą su atsakymais į visus pateiktus klausimus pridėję PDF ţemėlapį pateikite per Blackboard 

nuotolinio mokymo sistemą. 

 

PASIRUOŠIMAS 

Duomenys 

Šiam darbui reikalingus duomenis rasite Blackboard  nuotolinio mokymo sistemoje. Nusikopijuokite juos į 

savo kompiuterį. Atlikdami šio praktinio darbo 1-2 ţingsnius, ArcCatalog programa sukursite šiam praktiniam 

darbui reikalingą aplanką ir į jį įkelsite reikalingus duomenis. 
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Programinė įranga 

Šiam darbui reikia ArcGIS licencijos su galimybe naudoti ArcInfo. 

Literatūra ir elektroniniai vadovai 

 4 dalis: „Antžeminiai matavimai ir padėties nustatymas“: paskaitos tekstas ir PPT skaidrės. 

 Elektroninis ArcGIS darbalaukio žinynas 9.2: Kartografinio atvaizdavimo naudojimas  (Using 

cartographic representation) 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=An_overview_of_representations ir 

atvaizdavimo mokomoji medţiaga (Representations tutorial) 

http://webhelp.esri.com/arcgisdesktop/9.2/pdf/Representations_Tutorial.pdf. 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=An_overview_of_representations
http://webhelp.esri.com/arcgisdesktop/9.2/pdf/Representations_Tutorial.pdf
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UŽDUOTIS  

Scenarijus 
 

Buvo pageidauta sudaryti pagrindinių ţemėlapio elementų skaitmeninio topografinio ţemėlapio dalį 1:10 000 

masteliu. Iš anksto buvo pateikti kai kurie skaitmeniniai topografinės duomenų bazės duomenys 1:5 000 masteliu. 

Be to, jūs turite prieigą prie naujos šios srities aeronuotraukos. Turite sudaryti topografinį ţemėlapį pagal 

„Topografinio M1:10 000 ţemėlapio turinys, kodai ir sutartiniai ţenklai., GKTR 2.02.03.:2005 ” techninių 

reikalavimų reglamentą, esantį svetainėje http://www.agi.lt/lt/standartai.  
 

Galutinis jūsų produktas bus saugomas ArcGIS  geoduomenų bazės .gdb formatu ir apims geometriją bei 

kartografinį atvaizdavimą pagal reikalavimus, keliamus 1:10 000 masteliui. Duomenys turi būti LKS-94 

koordinačių sistemoje. 

 

Sprendimo taisyklė: sudarant smulkesnio mastelio ţemėlapius (maţiau detalius topografinius ţemėlapius) turi būti 

naudojami detalesnių duomenų šaltiniai (stambesnio mastelio).  Pavyzdţiui, sudarant 1:10 000 mastelio ţemėlapius 

gali būti naudojama 1:5 000 mastelio skaitmeninių duomenų bazė. 

 

1) Naudodami ArcCatalog programą savo kompiuteryje sukurkite GII06_5 aplanką (dešiniuoju pelės mygtuku 

spustelėkite norimą aplanką > New > Folder > (naujas > aplankas) ir įveskite pavadinimą GII06_5).  
 

2) Nukopijuokite visus iš Blackboard sistemos atsisiųstus šio praktinio darbo failus į darbinį kompiuterio GII06_5 
aplanką. 

 

Pirminių duomenų peržiūra 
 
ArcGIS programa gali dirbti su geoduomenų bazėse arba įvairių GIS formatų failuose (pvz., „shape“) saugoma 

geografine informacija. Duomenims redaguoti ir valdyti daugiausia naudojamos geoduomenų bazės. Geoduomenų 

bazė yra įvairių tipų geografinių duomenų rinkinių sankaupa. 
 

3) Atverkite ArcMap ir pridėkite visus duomenis ţemėlapyje kaip Topo.gdb sluoksnius. Dar pridėkite 

ţemėlapyje 7450.img aeronuotrauką, kaip vidutinės spalvų kokybės sudėtinį atvaizdo sluoksnį. 

 

4) Pakeiskite 7450 > simbolikos (Symbology) > kortelės sluoksnio ypatybių tipą Stretch Type (tempimo tipą) į 

None (nėra). Spustelėkite OK (gerai). Jūs pakeitėte atvaizdo spalvų schemą į pradinę, kuri yra natūralesnė. 

 

5) Ištirkite savo duomenų koordinačių sistemą. 

 

6) Visų pirma pakeiskite duomenų mastelį į 1:5 000  ir ištirkite atvaizduojamą sritį. Dabar 

pakeiskite mastelį į 1:10 000 – tai jūsų ţemėlapio mastelis. Pamatysite, kad jums reikės ne tik generalizuoti 

esamus duomenis iš 1:5 000 į 1:10 000 mastelį, bet dar galėsite atnaujinti generalizuotus duomenis (pvz., kelių 

duomenis). 

 

7) Galite įtraukti 1:5 000 mastelį į Map Scale (ţemėlapio mastelių) sąrašą. Tada nereikės vėl įvesti jo iš naujo.  

Atidarykite Map Scale (ţemėlapio mastelių) sąrašą > pasirinkite parinktį Customize This List (pritaikyti šį 

 

http://www.agi.lt/lt/standartai
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sąrašą) > įveskite 1:5 000 ir spustelėkite OK.  

 

8)  Įrašykite ţemėlapio dokumentą. 

1 klausimas. Ar reikia keisti galutinio žemėlapio koordinačių sistemą? 

 

 

1 

Šioje uţduotyje dirbsite tik su trijų tipų objektais: upėmis (hidro), pastatais (pastatai) ir gatvėmis (galtves). Jei 

norite sukurti išsamų topografinį ţemėlapį, turėsite suderinti visus GKTR techninių reikalavimų reglamente 

apibūdintus topografinius elementus. 

 

Iš pradţių turėsite generalizuoti arba paruošti 1: 5 000 mastelio geometrinius elementus taip, kad būtų patenkinti 

1:10 000 mastelio ţemėlapio reikalavimai. Tada turėsite atnaujinti kai kuriuos geometrinius elementus naudodami 

naują aeronuotrauką. Galiausiai turėsite kartografiškai atvaizduoti 1:10 000 mastelio ţemėlapio elementus 

naudodami ArcGIS 9.2 programos funkciją Representation (atvaizdavimas). 

 

1:10 000 mastelio žemėlapio duomenų suderinimas 
 

Iš pradţių reikės generalizuoti kelių tinklą.  

 

9) Atsisiųskite „Topografinio M1:10 000 ţemėlapio turinys, kodai ir sutartiniai ţenklai. GKTR 2.02.03.:2005“. 

Perskaitykite 23–27 reglamento puslapiuose esančią informaciją ir susipaţinkite su gatvėms bei keliams, 

vaizduojamiems 1:10 000 mastelio topografiniame ţemėlapyje, keliamais reikalavimais ir taikomais sutartiniais 

ţenklais. 

 

2 klausimas. Kokia simbolika (poligonai ir (ar) linijos) naudojama atvaizduojant gatves ir kelius 1:10 000 mastelio 

topografiniuose žemėlapiuose? 

 

 

 

1 

3 klausimas. Nurodykite šioje jūsų topografinio žemėlapio dalyje esančių kelių tipus. 

 

 

 

 

1 
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10) Suaktyvinkite erdvinės analizės (Spatial Analyst) plėtinį: įrankių meniu (Tools) > plėtiniai (Extensions) > 

paţymėkite erdvinės analizės (Spatial Analyst) langelį. Jei aktyvūs ne visi pasiekiami įrankiai, viena iš 

prieţasčių gali būti ta, kad nėra suaktyvintas reikiamas plėtinys.  

 

11) Dabar turite pakeisti 1:5 000 mastelio gatvių (gatves) poligonus į 1:10 000 mastelio gatvių centrines linijas. 

Vėliau bus galima šias linijas generalizuoti.  

 ArcToolbox  ieškokite  įrankio „poligonas į rastrą“ (Polygon to Raster). 

Paleiskite šį įrankį. Konvertuokite gatvių (gatves) sluoksnį, vertės lauke (Value field ) pasirinkdami 

GKODAS atributų lauką,  ir įrašykite į Topo.gdb. Output Raster Dataset (išvesties rastro duomenų 

rinkinio) pavadinimas gali būti gatves_R. Gardelės dydis (Cellsize) - 1. Kitiems nustatymams naudokite 

iš anksto nustatytus parametrus. 

 

 Tada ieškokite retinimo (Thin) įrankio ir jį paleiskite. Retinimo (Thin) įrankis sumaţina gardelių, 

nurodančių elementų plotį, skaičių. gatves_R rastrui naudokite šį įrankį nustatę šiuos parametrus: 

išvesties rastras (Output raster) > Thin_gatves_R, fono vertė (Background value) > ZERO (nulis), 

kampų ryškumas (Sharpe for corners) > SHARP (ryšku), didţiausias leistinas įvesties linijinio elemento 

storis (Maximum thickness of input linear feature) > 10. Spauskite OK.  

 

 Dabar konvertuosite rastrą į vektorių (Rastre to polyline), kad būtų galima sukurti 1:10 000 mastelio 

ţemėlapio gatvių centrines linijas. Įvesties rastras (Input raster) bus Thin_gatves_R, laukas (Field) > 

Value (vertė), išvesties polilinijų elementai (Output polyline features) > Topo.gdb\gatves_l, fono vertė 

(Background value) > ZERO (nulis). 

 

 Dabar generalizuosime gatvių polilinijas, kad jos būtų tiesesnės. Palyginti su 1:5 000 mastelio 

ţemėlapiais, 1:10 000 mastelio ţemėlapių detalumas maţesnis. Gatvės panašesnės į tiesias linijas, todėl 

naudosite linijos supaprastinimo (Simplify Line) įrankį. ArcToolbox suraskite ir paleiskite linijos 

supaprastinimo (Simplify Line) įrankį. Naudodami taškų šalinimo (POINT_REMOVE) supaprastinimo 

algoritmą (Simplification Algorithm) ir nustatę didţiausią leistiną 5 metrų poslinkį (5 Meters Maximum 

Allowed Offset) bei paţymėję langelius Check for topological errors (ieškoti topologinių klaidų) ir 

Resolve topological errors (ištaisyti topologines klaidas), supaprastinkite gatves_l į gatves1 išvesties 

elementų klasę (Output Feature Class).  

 

 Kad galėtumėte pamatyti supaprastinimo rezultatus, pakeiskite mastelį į 1:10 000.  5 metrų didţiausias 

leistinas poslinkis (5 Meters Maximum Allowed Offset) buvo pasirinktas po kelių iteracijų ir palyginimų 

naudojant skirtingus poslinkio parametrus. Išbandykite kitokius poslinkius ir galbūt jums pavyks rasti 

geresnį 1:10 000 mastelio ţemėlapio reikalavimų atitikmenį. 

 

 Galite pašalinti gatves1_Pnt, Thin_gatves_R, gatves_R ir gatves_l iš ţemėlapio dokumento. 

Įrašykite ţemėlapio dokumentą. Atverkite ArcCatalog ir panaikinkite šias gatves1_Pnt, 
Thin_gatves_R, gatves_R ir gatves_l klases iš Topo.gdb. 

 

 Vykdant pirmiau minėtus veiksmus gali kilti konfliktų dėl duomenų koordinačių sistemų projekcijų 

skirtumų. Įrankių languose galite pamatyti šį pranešimą 

 (parametrų konfliktas tarp ţemėlapio ir išvesties 

duomenų). Jūs turite naudoti geografinio apdorojimo numatytąjį nustatymą . Galite 

nekreipti dėmesio į šį pranešimą, kol baigsite pirmiau minėtus veiksmus. Šią klaidą ištaisysime dabar. 

ArcToolbox raskite ir paleiskite įrankį Define Projection (apibrėţti projekciją). Apibrėţkite gatves1 

elementų klasės projekciją naudodami importavimą (Import) iš, pvz., Extent (aprėptis) elementų klasės. 

Spustelėkite OK. 
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12) Jei palyginsite gatves1 elementus su esama 7450 aeronuotrauka, galite pamatyti kelis neatitikimus, kurių 

galėjo atsirasti dėl supaprastinimo proceso arba laiko kitimų. Galite juos ištaisyti redaguodami ir 

skaitmenindami rankiniu būdu. 

 

 Redaktoriaus (Editor) įrankių juostoje pradėkite redagavimą (Start Editing). Redagavimo paskirties 

sluoksnis bus gatves1. Kad būtų patogiau, galite pakeisti mastelį į visišką aprėptį (Full Extent). 

Norėdami atnaujinti ir patobulinti savo kelių tinklą galite atlikti kelis veiksmus. 

 

 Redaktoriaus (Editor) išskleidţiamame meniu> pritraukimas (Snapping) > paţymėkite pritraukimą prie 

gatves1 ir Extent sluoksnių viršūnių (Vertex), kraštinių (Edge) ir pabaigos taškų (End)  

 

 
. Uţdarykite pritraukimo (Snapping) langą.  

 

 Šioje teritorijoje  galite panaikinti kurį nors polilinijų segmentą ir iš naujo sukurti duomenis 

skaitmeninant. Daugiau informacijos apie redagavimą rasite ţinyno svetainėje 

http://webhelp.esri.com/arcgisdesktop/9.2/. 

 

 Jei norite panaikinti poliliniją, pasirinkite ją naudodami redagavimo įrankį (Edit Tool) , tada, norėdami 

panaikinti, naudokite naikinimo (Delete) mygtuką. Pvz., . Ţr. 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Deleting_features.  

 

 Jei norite panaikinti polilinijos segmentą, galite dukart spustelėti ją naudodami redagavimo įrankį (Edit 

Tool)  ir panaikinti nereikalingą viršūnę: pelės ţymeklį perkelkite ant viršūnės kvadrato , ţymeklis 

pasikeis į  > spustelėkite jį dešiniuoju pelės mygtuku > pasirinkite Delete Vertex (naikinti viršūnę), 

http://webhelp.esri.com/arcgisdesktop/9.2/
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Deleting_features
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pvz., bus panaikinta paskutinė viršūnė (paţymėta raudonai)  > spustelėkite kur 

nors uţ linijos. Jei reikia pagalbos, ţr. 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Adding_and_deleting_vertices.  

 

 Dar galite naudoti redaktoriaus (Editor) įrankių juostos linijų skaidymo (Split Line)  įrankį ir perskirti 

pasirinktą elementą, o vėliau panaikinti nereikalingą atskirtą dalį. 

 

 Iš naujo skaitmeninkite trūkstamas gatvės dalis naudodami redaktoriaus (Editor) įrankių juostoje esantį 

eskizų (Sketch Tool)  įrankį. Nepamirškite naujus elementus pritraukti prie esamų linijų pabaigos. 

Pavyzdţiui, pradėkite skaitmeninti perkeldami ţymeklį ant esamos gatvės elemento pabaigos. Tada 

pamatysite pritraukimą prie elemento pabaigos taško . Norėdami pradėti naują gatvę, 

kairiuoju pelės mygtuku spustelėkite šį tašką. Skaitmeninkite gatvės liniją pagal aeronuotrauką 

spustelėdami kairįjį pelės mygtuką. Pritraukite prie kitos gatvės pabaigos, tada, norėdami uţbaigti naujos 

gatvės polilinijos eskizą  dukart spustelėkite pelės mygtuką arba 

naudokite klavišą F2. Retkarčiais įrašykite pataisymus (Save Edits). Jei reikia pagalbos, ţr. 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Creating_lines_and_polygons. 

 

 Dar galite ištemti esamą elementą perkeldami paskutinę viršūnę arba tašką: pelės mygtuku dukart 

spustelėkite poliliniją ir tempkite paskutinį jos mazgą iki reikiamos vietos (pvz., esamos linijos kraštas) 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Adding_and_deleting_vertices
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Creating_lines_and_polygons
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. 

 

 Dar galite pakeisti gatvės poliliniją, kad ji geriau atitiktų aeronuotraukos gatvių sistemą. Norėdami tai 

atlikti galite įterpti naują viršūnę. dukart spustelėkite ant linijos > dešiniuoju pelės klavišu spustelėkite 

paryškintą liniją toje vietoje, kurioje norite įterpti naują viršūnę > pasirinkite Insert Vertex (įterpti viršūnę) 

. Tada galite temti viršūnę į naują vietą 

, kad ji geriau atitiktų esamą kelią. Norėdami baigti eskizą 

paspauskite F2. Dar ţr. 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Adding_and_deleting_vertices ir 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Moving_vertices. Galite taisyti ir kitų 

gatvių padėtį. Nepamirškite kartais įrašyti taisymus (Save Edits). 

 

 Jei norite redaguoti bendrai naudojamus mazgus (node) ir (ar) naujų elementų viršūnes (vertex), galite 

naudoti topologijos (Topology) įrankių juostos įrankius. Daugiau informacijos apie ţemėlapio topologiją 

rasite svetainėje http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=About_topology.  

 

 Pridėkite topologijos (Topology) įrankių juostą: View > Toolbars > pasirinkite Topology. 

 Redagavimo seansas dar neturi būti baigtas; jei baigėte redagavimą (Stop Editing), įrankių juostoje 

Editor (redaktorius) spustelėkite Editor (redaktoriaus) išskleidţiamąją rodyklę ir spustelėkite Start 

Editing (pradėti redagavimą). 

 Paskirties (Target ) sluoksnis vis dar turi būti gatvės1. 

 Spustelėkite topologijos (Topology ) įrankių juostos ţemėlapio topologijos (Map topology) 

mygtuką . 

 Paţymėkite gatves1 elementų klasę, kuri dalyvaus ţemėlapio topologijoje. Nekeiskite ţemėlapio 

topologijos klasterio tolerancijos (Cluster Toleranse). Numatytoji klasterio tolerancija yra 

maţiausia leistina klasterio tolerancija. Padidinus klasterio toleranciją gali susijungti keli elementai 

ir tapti sutampančiais elementais, bet tai gali sumaţinti jūsų duomenų erdvinį tikslumą. 

 Spustelėkite OK. Sukurta ekrane rodomų elementų ţemėlapio topologija. 

 Spustelėkite topologijos redagavimo (Topology Edit) įrankį , tada spustelėkite kairėje esantį 

pagrindinių kelių susikirtimo mazgą. . Purpurine spalva bus paţymėti tik 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Adding_and_deleting_vertices
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Moving_vertices
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=About_topology
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susikertantys mazgai. Dabar galite perkelti šiuos mazgus į dešinę . Bus 

pakoreguotos visos susikertančios linijos ir pabaigos mazgai. Daugiau informacijos apie 

susikertančios geometrijos redagavimą rasite svetainėje 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Editing_shared_geometry. 

Nepamirškite kartais išsaugoti taisymus (Save Edits). 

 

 Privalote patikrinti visas ţemėlapyje esančias gatves, atnaujinti ir ištaisyti neatitikimus ir pridėti gatvių 

segmentus. ArcMap turi daug greito, patogaus ir tikslaus redagavimo galimybių, tačiau jūs išmoksite 

naudoti tik kelias iš jų. 

 

13) Baigę redagavimą (Save Edits (taisymų įrašymas) bei Stop Editing (baigti redagavimą)), pakeiskite mastelį į 

Full Extent (visos aprėpties) ir pridėkite naują teksto (Text) lauką Tipas į gatves1atributų lentelę : dešiniuoju 

pelės mygtuku spustelėkite gatves1 sluoksnį > Open Attribute Table > Options > Add Field (atidaryti atributų 

lentelę > parinktys > pridėti lauką).  

 

14) Dabar lauke Tipas įvesite gatves tipo aprašus atsiţvelgdami į „Topografinio M1:10 000 ţemėlapio turinys, 

kodai ir sutartiniai ţenklai., GKTR 2.02.03.:2005 ” techninių reikalavimų reglamentą.  

 

 Vėl pradėkite redaguoti (Start Editing) gatves1. Galite uţdaryti atributų lentelę. Pasirinkite  pirmą 

gatvės liniją, redaktoriaus (Editor) meniu atidarykite Attributes (atributų)  dialogo langą ir į lauką 

Tipas įveskite pasirinktos gatvės tipą. 

 Pasirinkite kitą gatvę ir įveskite jos atributus.  

 Įveskite likusių ţemėlapyje esančių gatvių atributus. 

 Išsaugokite redagavimą (Save Editing). Įrašykite ţemėlapio dokumentą . Ţemėlapio topologijos (Map 

topology) dialogo lange  panaikinkite gatves1 ţemėlapio topologijos ţymėjimą. Dar kartą įrašykite 

ţemėlapio dokumentą. Baikite redagavimą (Stop Editing). 

 

Baigėte naujinti ţemėlapio gatvių tinklo išdėstymą.  

15) Dabar galite pradėti kurti ţemėlapio geometriją. Grįţkite susipaţinti su atvaizdavimo kūrimu, kuris išdėstytas 

„Topografinio M1:10 000 ţemėlapio turinys, kodai ir sutartiniai ţenklai., GKTR 2.02.03.:2005 ” techninių 

reikalavimų reglamento”, 30–34 p. Atkreipkite dėmesį į 33 ir 34 p. pateiktas generalizavimo taisykles. 

 

16) Iš pradţių performuosite kiekvieno pastato sudėtines dalis į vieną pastato poligoną. Atsiţvelgiant į GKTR 

2.02.03.:2005, pastatai, esantys arčiau negu trys metrai vienas nuo kito, turi būti sujungti (laikysime, kad tai 

vieno pastato sudėtinės dalys). Daugiau informacijos apie įrankį, kuris padės atlikti šią operaciją ieškokite 

svetainėje 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=1568&pid=1565&topicname=Dissolve_(Data_Manag

ement).  

 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Editing_shared_geometry
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=1568&pid=1565&topicname=Dissolve_(Data_Management)
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=1568&pid=1565&topicname=Dissolve_(Data_Management)
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 ArcToolbox  raskite ir paleiskite išformavimo (Dissolve) įrankį. Pastatai sluoksnis bus įvesties 

sluoksnis. Išvesties elemento klasė bus pastatai_D. Išformavimo lauke paţymėkite STOG_H. Kitų 

parametrų nustatyti nereikės. Dialogo lango apačioje reikia panaikinti  parinkties 

ţymėjimą! 

 

 Paleiskite įrankį. 

 

17) Norėdami generalizuoti apjungtus ankstesniame ţingsnyje pastatus iš 1:5 000 mastelio į 1:10 000 mastelį jūs 

naudosite ArcToolbox  įrankį Simplify Building (supaprastinti pastatą). Informacijos apie šio algoritmo 

veikimą rasite svetainėje 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?topicname=how_simplify_building_(data_management)_

works. 

 

 ArcToolbox raskite ir atidarykite šį įrankį. 

 Bus atnaujintas pastatai_D sluoksnis. Output Feature Class (išvesties elementų klasė) bus 

Topo.gdb\pastatai_S. Supaprastinimo tolerancija bus parinkta atsiţvelgiant į GKTR 2.02.03.:2005 

techninių reikalavimų reglamento nurodymus. Supaprastinimo tolerancija (Simplification Tolerance) bus 

5 metrai, o maţiausias plotas (Minimum Area) – 25 kv. m. Galite patikrinti, ar nėra erdvinių konfliktų 

(Check for spatial conflicts). 

 Paleiskite įrankį. Į ţemėlapį bus įtrauktas naujas supaprastintų pastatų sluoksnis pastatai_S. 

 

18) Dar kartą paleiskite įranki Simplify Building (supaprastinti pastatą). pastatai_S sluoksniui nustatykite 5 metrų 

supaprastinimo toleranciją (Simplification Tolerance) ir sukurkite patobulintą duomenų išvesties failą 

pastatai_SS. 

4 klausimas. Kodėl reikia naudoti 5 metrų supaprastinimo toleranciją? (Atsakymo į šį klausimą ieškokite GKTR 

2.02.03.:2005 techninių reikalavimų reglamente.) 

 

 

 

 

 

 

1 

5 klausimas. Kodėl reikia naudoti 25 kv. m mažiausio ploto toleranciją?  

 

 

 

 

 

 

1 

19) Pastatų supaprastinimo algoritmas gali pateikti naudingus rezultatus, bet gali prireikti tolesnio apdorojimo ir 

(ar) rankinio redagavimo. Galite perţiūrėti visus ţemėlapyje esančius pastatus ir prireikus galite pradėti 

pastatai_SS redagavimą ir naudoti eskizų įrankį (Sketch Tool) , kad galėtumėte pakeisti pastatų formą ir 

panaikinti nereikalingas viršūnes bei dalis. Daugiau informacijos apie redagavimą rasite: 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Reshaping_lines_and_polygons_using_a_sk

etch. 

 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?topicname=how_simplify_building_(data_management)_works
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?topicname=how_simplify_building_(data_management)_works
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Reshaping_lines_and_polygons_using_a_sketch
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Reshaping_lines_and_polygons_using_a_sketch
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20) Baigę redaguoti pastatai_SS sluoksnį, išsaugokite pataisymus (Save Edits) ir ţemėlapio dokumentą. Vėliau 

atliekant šią uţduotį jums reikės patobulinti pastatų padėtis atsiţvelgiant į kelius. 

 

21) Pašalinkite pastatai_S, pastatai_D ir pastatai sluoksnius iš turinio ir įrašykite ţemėlapio dokumentą. 

 

Jei sukursite nereikalingų sluoksnių Topo.gdb, galite atidaryti ArcCatalog, naršyti Topo.gdb (norėdami atidaryti 

Topo.gdb, dukart spustelėkite pelės mygtuką) ir panaikinti nereikalingą elementų klasę ją paţymėję ir paspaudę 

naikinimo klavišą arba mygtuką Delete (naikinti) , esantį standartinėje (Standard) įrankių juostoje. Galite 

išvalyti duomenų bazę ir ją suglaudinti, kad sumaţintumėte jos dydį (dešiniuoju pelės mygtuku spustelėkite > 

Compress File Database (suglaudinti failinę duomenų bazę). 

6 klausimas. Kokių konfliktų kilo tarp žemėlapyje esančių gatvių (gatves1) ir  pastatų (pastatai_SS)?  

 

 

 

1 

22) Kitas ţemėlapio elementas, kurį turite generalizuoti, yra upių tinklas. hidro (upių) elementų klasės 

generalizavimą reglamentuoja hidrografijos taisyklių ir sutartinių ţenklų specifikacija, esanti GKTR 

2.02.03.:2005, 11-13 p. Generalizuodami galite remtis jau atliktu gatvių supaprastinamo procesu. Dar galite 

išmėginti du naujus ArcToolbox įrankius – Simplify Line (supaprastinti liniją) ir Smooth Line (glodinti liniją), 

be to, išmėginkite skirtingus šių įrankių algoritmus ir tolerancijos vertes. Raskite geriausią būdą ir gaukite 

atitinkamą rezultatą.  Topo.gdb įrašykite galutinį hidro1 elementų klasės generalizavimą. 

 

7 klausimas. Išvardykite ir trumpai apibūdinkite veiksmus, kuriuos naudodami sukuriate hidro1 elementų klasę. 

 

 

 

 

 

 

 

 

 

2 

8 klausimas. Koks GKTR 2.02.03.:2005 techninų reikalavimųo reglamento kodas (-ai) atitinka jūsų žemėlapio upių 

tinklo atvaizdavimus? 

 

 

 

1 

Kartografinis 1:10 000 žemėlapio mastelio atvaizdavimas 
 

Suderinote išdėstymą, kuris atitinka 1:10 000 ţemėlapio mastelį. Naudodami šį mastelį turite kurti šio išdėstymo 

sutartinius ţenklus atsiţvelgdami į „Topografinio M1:10 000 ţemėlapio turinys, kodai ir sutartiniai ţenklai., GKTR 

2.02.03.:2005“ techninių reikalavimų reglamentą. 

 

23) Priskirkite reikiamus simbolius gatves1 sluoksniui: 
 

 Dešiniuoju pelės mygtuku spustelėkite gatves1 sluoksnį ir pasirinkite Properties > Symbology skyrelį > 

Categories > Unique values > Value Field (ypatybės > legendos > kategorijos > unikalios vertės > vertės 

laukas bus Tipas > panaikinkite all other values (visų kitų verčių) ţymėjimą > pasirinkite reikiamą 
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simbolį atsiţvelgdami į GKTR 2.02.03.:2005 techninių reikalavimų reglamentą.  

 

 Dukart spustelėkite simbolį ir pakeiskite atitinkamo simbolio vaizdinį kintamąjį (plotį, fono spalvą, 

kontūrus ir t. t.) į panašiausią reglamento reikalavimų atitikmenį. Iš išskleidţiamosios rodyklės sąrašo 

More Symbols (daugiau simbolių) galite pridėti transportavimo (Transportation) simbolių.  

 

 Naudokite kelių sluoksnių (multi-layer) simbolius, pvz.,  arba  simbolius, kurie 

pasiekiami paspaudus Simbolizacijos (Symbology) skyrelio ypatybę Advanced (išsamiau). Paspauskite 

mygtuką Advanced (išsamiau) > Symbol Levels (simbolių lygiai) > paţymėkite langelį Draw this layer 

using the symbol levels specified below (brėţti šį sluoksnį naudojant toliau nurodytus simbolių lygius) > 

perkelkite  gatves į aukštesnę viršuje esančią klasę > paţymėkite visus langelius Join (sujungti) ir 

Merge (sulieti). Perkelkite pelės ţymeklį į Symbol Level (simbolių lygio) dialogo langą ir paspauskite 

mygtuką F1, jei norite daugiau suţinoti apie papildomas parinktis. Papildomos (Advanced) parinktys 

keičia grubius linijų sujungimus  į kartografinius linijų derinus . Sujungti (Join) 

galima tik kelių lygių (multi-layer) simbolius. Sulieti (Merge) galima skirtingų lygių simbolius. Daugiau 

informacijos rasite svetainėje 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Working_with_symbol_levels. 

 

 Dar galite spustelėti mygtuką Properties (ypatybės) ir suaktyvinti Symbol Property Editor (Simbolių 

ypatybių redaktorių), kad galėtumėte pritaikyti simbolį. Pasirinkę sluoksnį ir pakeitę jo ypatybes 

(Properties) kairėje esančiuose skirtukuose, pvz., , galite keisti kiekvieno sluoksnio, 

kuris naudojamas kuriant kelių sluoksnių simbolius, plotį, spalvą ir modelį. Koreguokite savo simbolius 

taip, kad jie kuo labiau atitiktų GKTR 2.02.03.:2005 techninių reikalavimų reglamento reikalavimus. 

 

 Baigę kurti simbolius spustelėkite OK ir uţdarykite gatves1 sluoksnio ypatybių (Properties) dialogo 

langą bei įrašykite (Save) savo ţemėlapio dokumentą.  

 

 Dar galite įrašyti gatves1 sluoksnio simboliką į .lyr failą, kad būtų galima naudoti ją vėliau: dešiniuoju 

pelės mygtuku spustelėkite gatves1 sluoksnį > Save as Layer File > Save (įrašyti kaip sluoksnio failą > 

įrašyti). 

24) Dabar jums reikės sukurti pastatai_SS sluoksnio kartografinį atvaizdavimą.  

 

Naujos ArcGIS 9.2 programos funkcijos suteikia galimybę išsaugoti simboliką su elemento išdėstymu geografinių 

duomenų bazėje ir redaguoti ţemėlapyje atskiro elemento vaizdavimą bei išdėstymą. Dabar galite saugoti 

alternatyvų elemento išdėstymą, kuris naudojamas tik vaizdavimui, ir išsaugoti pirminį išdėstymą tame pačiame 

duomenų faile.  

 

ArcGIS programos atvaizdavimo (Representation) įrankis teikia atskirų kartografavimo simbolių atvaizdavimo 

sąsają ir redagavimo įrankių, skirtų modifikuoti elementų, simbolizuotų atvaizdavimuose, rinkinį. Atvaizdavimo 

informaciją galima saugoti tik geografinių duomenų bazės failuose. Šiuo tikslu negalima naudoti Shape failų. 

Daugiau informacijos apie ESRI kartografinį atvaizdavimą rasite svetainėje 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=An_overview_of_representations. 

 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Working_with_symbol_levels
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=An_overview_of_representations
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 Suaktyvinkite atvaizdavimo (Representation) įrankių juostą: View > Toolbars > Representation.  

 

 Kurkite pastatų simbolius (apvadą ir uţpildo spalvą), atsiţvelgdami į GKTR 2.02.03.:2005 techninių 

reikalavimų reglamentą. 

 

 Dešiniuoju pelės mygtuku spustelėkite pastatai_SS sluoksnį ir pasirinkite Convert Symbology to 

Representation (konvertuoti simboliką į atvaizdavimą). Atveriamas dialogo langas Convert Symbology to 

Representation (konvertuoti simboliką į atvaizdavimą). 

 

 Sutikite su naujos elementų klasės atvaizdavimo pavadinimu pastatai_SS_Rep. 

 

 Sutikite su laukų RuleID ir Override pavadinimais. Pridėdami atvaizdavimą prie elementų klasės jūs 

pridedate du laukus prie elementų klasės lentelės, kad galėtumėte išsaugoti papildomą informaciją, kuri 

nurodo elementų klasei, kaip kurti jos elementų simbolius, kai sluoksnis brėţiamas naudojant elementų 

klasės atvaizdavimą. RuleID laukas yra sveikųjų skaičių laukas, kuriame saugoma atvaizdavimo taisyklių 

nuoroda. Atvaizdavimo taisyklės informacija saugoma geografinių duomenų bazės sistemos lentelėse. 

Override laukas yra dvejetainis didelių objektų (BLOB) laukas, kuriame saugomi konkretaus elemento 

atvaizdavimo taisyklių nepaisymai. Nepaisymai yra atvaizdavimo ypatybių keitimai elementų lygiu ir gali 

apimti elemento atvaizdavimo išdėstymo keitimus; atsiţvelgiant į tai, kaip nustatytas atvaizdavimo 

redagavimo veikimas. 

 

 Pasirinkite Store change to geometry as representation override (saugoti išdėstymo keitimą kaip 

atvaizdavimo nepaisymą), kad galėtumėte padėti visus elemento atvaizdavimo išdėstymo modifikavimus 

lauke Override field, palikdami nepakeistą Shape lauką (geometrijos lauką). Parinktis Change the 

geometry of the supporting feature (keisti palaikomo elemento išdėstymą) skirta elemento atvaizdavimo 

išdėstymo redagavimui, keičiant ir elemento tikrąją geometriją, vykdyti. Šios parinkties jūs nenaudosite. 

 

 Jums reikės konvertuoti visą elementų (geoobjektų) klasę į atvaizdavimą (All features). 

 

 Paţymėkite Add new layer to map symbolized with this representation (pridėti naują elementų klasės 

atvaizdavimą prie esamo ţemėlapio). Pradinis sluoksnis bus rodomas turinyje, neatsiţvelgiant į jūsų 

pasirinkimą. 

 

 Spustelėkite Convert (konvertuoti). Naujas elementų klasės atvaizdavimas, sukurtas naudojant 

atvaizdavimo taisykles, atitinkančias simbolių, naudojamų pirminiame sluoksnyje, vaizdą, pridedamas 

prie pirminės elementų klasės. 

 

 Panaikinkite pradinio gatves_SS sluoksnio matomumo ţymėjimą. 

 

25) Matote, kad viršutinėje kairėje srityje tarp namų ir gatvių yra nesuderinamumų  

arba pastatai gali būti per arti gatvės. Jūs naudosite gatves_SS_Rep atvaizdavimo failą ir suderinsite šiuos 

konfliktus nekeičiant pradinių gatves_SS duomenų. 

 

 Tegu gatves_SS_Rep būna vienintelis sluoksnis, kurio objektus galite paţymėti (select): dešiniuoju 

pelės mygtuku spustelėkite pastatai_SS_Rep sluoksnį > Selection > Make This The Only Selectable 

Layer (pasirinkta sritis > tegu jis būna vienintelis pasirenkamas sluoksnis). 
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 Pradėkite redaguoti gatves_SS_Rep (paskirties sluoksnis (Target)). Galite priartinti (zoom in) 

konfliktuojančius pastatus. 

 

 Naudodami atvaizdavimo (Representation ) įrankių juostos pasirinkimo įrankį (Select tool)  

pasirinkite pirmąjį pastatų konfliktą. Atkreipkite dėmesį į aplink jį esantį stačiakampį pasirinkimo lauką. 

 

 Perkelkite pelės ţymeklį ant pastato ir tempkite jį ant gatvės linijos 3 metrus (atsiţvelgdami į GKTR 

2.02.03.:2005 techninių reikalavimų reglamentą, atskiri pastatai turi būti ne arčiau negu 3 metrai vienas 

nuo kito). 

 

 Galite paieškoti kitų konfliktų tarp gatvių linijų ir pastatų ar net vien tik tarp pastatų. Jei norite, galite 

ištaisyti konfliktus.    

 

 Baikite redaguoti (Stop Editing) ir įrašykite (Save) savo redagavimus. 

 

 Paţymėkite gatves_SS elementų klasės matomumą. Atkreipkite dėmesį, kad pradinės padėtys nebuvo 

pakeistos, nors buvo redaguotas atvaizdavimas. 

 

 Baigdami analizuoti šiuos keitimus, panaikinkite gatves_SS elementų klasės matomumo ţymėjimą. 

 

Tobulinant kartografinį dizainą kartografinio atvaizdavimo (Representation) įrankio funkcijos yra gana plačiai 

pritaikomos. Pavyzdţiui, galite naudoti jį, jei norite valdyti linijinių simbolių brūkšnelius (pvz.,   į ); 

kurti sudėtinius poligonų uţpildus, kurti kelių viadukų ir tunelių simboliką ir t. t. Apie ESRI atvaizdavimą 

(Representation) galite suţinoti elektroninėje mokomojoje medţiagoje, svetainėje 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Cartographic_representations_tutorial.  

26) Sukurkite hidro1 sluoksnį atsiţvelgdami į GKTR 2.02.03.:2005 techninių reikalavimų reglamentą.  

Norint suderinti ir sukurti išsamius topografinius ţemėlapius jums reikėtų įtraukti į ţemėlapį papildomų elementų, 

pvz., pastatų blokų planą, kontūrų linijas, augalus, infrastruktūros objektus ir t. t. Be to, ţemėlapyje turėtų būti 

panaudotos tekstinės ţymės (objektų parametrai ir/ar pavadinimai). Šioje uţduotyje jūs suderinote ir sukūrėte tik 

kelis reikalaujamus elementus, esančius topografiniame ţemėlapyje. Apie elementų tekstines ţymes suţinosite 

kitame laboratoriniame darbe. 

 

27) Įrašykite savo galutinį ţemėlapio, kuriame yra sukurti gatves1, pastatai_SS_Rep ir hidro1 sluoksniai, 

dokumentą. Eksportuokite šį ţemėlapį į PDF failą naudodami 300 dpi skiriamąją gebą. 

 

9 klausimas. Pateikite PDF failą, kuriame yra sukurti topografinio žemėlapio elementai. 3 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Cartographic_representations_tutorial

